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1. Introduction

The human body is the ultimate machine. Now you can explore its systems, stuctures and 
functions in fascinating detail with BODYWORKS 3.0   An Adventure in Anatomy. Colorful, 
comprehensive graphics guide you on a journey through the body. With its vast database, 
BODYWORKS 3.0 lets you study specific areas from head to toe, zooming in and out for a 
complete look at the world within you, and focusing on different internal systems such as the 
skeletal, muscular cardiovascular, reproductive and more.
* Magnified views and cutaways reveal even the most elaborate cell structure
* Detailed animations bring the intricate functions of the body to life
* Phonetic "smart search" directs you to any part of the body   even if you're not sure how it's 
spelled
* Advanced "speech back" sound lets you hear the correct pronunciation for items from the aorta 
to the zygomatic bone
* Special health section provides information on first aid, general fitness, sports injuries and 
common illnesses
* Easy exporting of text and graphic to a wide variety of printers for creation of customized reports

2. Program Requirements

System Requirements
DOS Version
IBM PC or compatible
520K RAM
DOS 3.3 or above
VGA Color Graphics
Hard disk drive (uses 6MB; 8.5MB with optional files )
3.5" disk drive
Mouse recommended
Sound Blaster or compatible card recommended
Windows Version IBM PC or compatible Microsoft Windows 3.1 4MB RAM VGA Color Graphics 
(256 color driver recommended) Hard disk drive (uses 6MB; 8.5MB with optional files) 3.5" disk 
drive Microsoft Mouse or compatible required Sound Blaster or compatible card recommended

3. BODYWORKS 3.0 for DOS: Getting Started
BODYWORKS 3.0 is an interactive information system designed to let you explore the system, 
structures and functions of the human body   the ultimate machine. Information is illustrated in 
both text and pictures. The system lets you move from one item to another, in any way you'd like 
to investigate.
The screen is divided into four main areas: the picture view box, the item list, the text box, and the
control buttons. A menu bar at the top provides access to functions which let you control your 
session and customize your program.

Text



If  you'd like to see the text associated with a topic, click on the "Text ()n" button at the bottom of 
the list. (Text can also be turned on by clicking the right mouse button, or by pressing the letter 'T' 
on your keyboard). The item list provides topics related to the current picture.

The text for the selected topic will be displayed in a box over the lower half of the item list
Scroll bars on the right side of the text box indicate there is more text than currently displayed.

To scroll through the text one line at a time without a mouse, use the Page Up/Page Down keys.
To scroll through the text one screen at a time, use CTRL+Page Up/Page Down.

If you prefer to see more text displayed at one time, you may enlarge the text box to fill the entire 
item list area by clicking on the up arrow icon in the top right corner of the text box, or by pressing
the letter "M" on your keyboard. You can shrink the text down again with the down arrow icon or 
by pressing the letter "M" again.

If you want to close the text box, you may do so at any time by clicking on the minus symbol in 
the upper left corner of the text box.

Topics

If you'd like more in depth information on a topic, click on its name in the item list. This will make 
the topic's text entry available, and draw a line to the item on the picture.

A red square appearing before an item name indicates that there is another picture associated 
with the item.  To see this new picture, double click on the item name.

Image List

The image list is a specialized index to the pictures in BODYWORKS. Rather than having access 
to all of the information in the program as you do with the standard index, this option lists the 
unique pictures only. You can select one and then press the "Goto" button. You can also call up 
this option using <Alt> I from your keyboard.

Sound

To help with the pronunciations of different words, BODYWORKS has a speech option. The 
program will speak the name of the item when you select it in the item list.

A speaker icon appearing before an item name indicates the "speech back" feature is available 
for that item. Be sure you have selected Sound On in the Options menu.

Any item which has a small speaker on the item button will speak. The program works best with 
an optional sound board, but it can also use the PC's internal speaker. The volume and quality of 
the speaker sound will depend on your system. The Sound On/Off function under the Options 
menu can disable speech if you would prefer to work without sound.

Mouse\Keyboard

When you use the program, you can select items in several ways. If you are using a mouse, 
simply point at the item and click your left mouse button. If you're using the keyboard, the current 
item will appear depressed. Use the arrow keys to change which button is current. Once you 
have the proper button highlighted, the <Enter> key or <Space bar> will make the selection. To 
scroll through any text in the text box at the bottom, use the <Pg Up>/<Pg Down> keys.



If you are using a mouse, you can also cIick on items in the picture to select them. If there is a red
dot next to the entry, you can select it a second time. This takes you to a new screen containing 
more information. This new screen will also have an item list that can take you to other screens. 
This lets you move from one topic to another, in any order you'd like.

As you explore through BODYWORKS', the program remembers the steps you take. The "Back 
arrow" button lets you backtrack along that line of exploration. This helps f you ge to a point 
where you'd like to back up and see what you've just previously covered.

The hypertext can be accessed using the <Tab> key. When you press this key, the arrows scroll 
through the hypertext entries rather than the other buttons. When you get to the entry you're 
interested in, you can select it with either the <Enter> key or <Space bar>. Hitting the <Tab> key 
again will return you to normal key movement.

The menu options are available from the keyboard. To activate the menus, press the <Alt> key 
and the first letter of one of the menus, <Alt> F for example for the File menu. You can then 
navigate using the arrow keys and make your selection with <Enter>. There are also "hotkeys" 
available to call up these functions. These keys are listed to the right of the menu items when the 
menus are pulled down.

"Holkey" Summary:
A: Toggle animations on and off
B: Browse the bookmarks
C: Choose color scheme
E: Export the current information
F: Font setup
G: Glossary
I: Open the index
L: Goto Lessons & Quizzes
+: Next entry in Lesson
-: Previous entry in lesson
M: Minimize/Maximize the text window
N: Open the note pad
P: Print
R: Printer Setup
S: Toggle sound effects on and off
T: Turn the text window on and off
0-9: Set the appropriate bookmark
<Shift> 0-9: Return to that bookmark
Backspace: Return to the last screen
Page Up: Scrolls up one line of text at a time
Page Down: Scrolls down one line of text at a time
<Ctrl> Page Up: Scrolls up one page at a time
<Ctrl> Page Down: Scrolls down one page at a time
<Alt> I: Image List
<Alt> M: Movie List
<Alt> R: Medical Records
<Alt> X: Exit the program
<Tab>: Toggle Hypertext mode
F1: Help system
F2: Run a movie *
F3: Front view *
F4: Back view *
F5: Side view *
F6: Bottom view *
*When Available



Hypertext

When you look at text entries for the various items in BODYWORKS, you will notice some words 
are highlighted or underlined. These are hypertext entries.

Hypertext is provided throughout the program to define terms and allow a way of branching off to 
other related issues.

Clicking on an underlined word will give a popup definition for that word. This provides a quick 
reference source for unfamiliar terms.

The highlighted words will link you to other screens. If you click on one, you will be taken to a 
screen that will give you more information about that item.

If there are several related items, it will give you a list. You can choose one, then press the "Goto"
button to go to that screen.

The hypertext can be accessed using the <Tab> key. When you press this key, the arrows scroll 
through the hypertext entries rather than the other buttons. When you get to the entry you're 
interested in, you can select it with either the <Enter> key or <Space bar>. Hitting the <Tab> key 
again will return you to normal key movement.

There are different perspective views for many of the images in BODYWORKS. They let you look 
at the front, side, bottom and back of items. When these views are available there will be buttons 
at thee bottom of the picture. you can click on one of these, or use the function keys listed on the 
buttons.

Movies

BODYWORKS includes several movie sequences. When a movie is available, there will be a 
small projector in the upper right corner of the picture. To run the movie, you click on that button, 
or press F2 on your keyboard.
When the movie is running, you can change several aspects of the way it plays. The commands 
will be displayed on the side of the movie. You can also run the movies from the Movie List option
found under the Tools menu. For more information on the movies, please see the section on 
Animations.

The Menus

The menu choices let you interact with many of the functions BODYWORKS provides. The 
menus are File, Options, Tools, Lessons and Help. You can activate the menus with your mouse, 
or from the keyboard with the <Alt> key and the first letter of the menu. <Alt F> for example would
activate the File menu.

The individual menu commands can be activated with the "hotkeys" listed to the right of each 
entry.
For a full list of "hotkeys" please refer to the section "Hotkey Summary "

The Buttons

The body systems represent the different anatomical systems of the body. They include: skeletal, 
muscular, nervous, cardiovascular, respiratory, digestive, sensory, lymphatic, endocrine and 
genitourinary. There are also sections on health & fitness and living. These systems are accessed



through the family buttons at the top of the screen. This help section gives an indication of what 
each family covers.

SKELETAL SYSTEM
The skeleton is the framework of the human anatomy, supporting the body and protecting its 
internal organs. Two hundred and six bones compose the skeleton. This section covers these 
bones and the ways in which they are connected.

MUSCULAR SYSTEM
the hum n body contains more than 650 individual muscles anchored to the skeleton, which 
provide pulling power so that you can move around. These muscles constitute about 40% of your 
total body weight. The body is moved primarily by muscle groups, and not by individual muscles. 
These groups of muscles power all actions ranging from the threading of a needle to the lifting of 
heavy weights. This section covers this group.

NERVOUS SYSTEM
The nervous system of the human anatomy is responsible for sending, receiving, and processing 
nerve impulses. All of the body's muscles and organs rely upon these nerve impulses to function. 
Three systems work together to carry out the mission of the nervous system: the central, the 
peripheral, and the autonomic nervous systems. This section covers these systems and includes 
items such as the brain, the spinal cord and other nerve groups of the body.

CARDIOVASCULAR SYSTEM
In order for the body to stay alive, each of its cells must receive a continuous supply of food and 
oxygen. At the same time, carbon dioxide and other materials produced by the cells must be 
picked up for removal from the body. This process is continually maintained by the bodies 
circulatory system. The primary circulatory system consists of the heart and blood vessels, which 
together maintain a continuous flow of blood through the body.

RESPIRATORY SYSTEM 
The respiratory system is responsible for supplying oxygen to the blood and expelling waste 
gases. This section covers the lungs, air passages and muscles which make the system work.

DIGESTIVE SYSTEM
The digestive system is responsible for processing food, breaking it down into usable proteins, 
carbohydrates, minerals, fats, and other substances, and introducing these into the bloodstream 
so that they can be used by the body. It includes the mouth, esophagus, stomach and intestines 
as well as the liver, gall bladder and pancreas.

SENSORY ORGANS
The sensory system includes the eyes, the ears, the nose and the mouth. The integumentary 
system is the name given for the skin, hair, nails, and glands covering the body. It is included here
as well, as the skin is the largest sensory organ.

ENDOCRINE SYSTEM
All the organs in the endocrine system are glands. They are unique from other glands, because 
they release chemicals known as hormones into general circulation. The organs of the endocrine 
system are located in widely separated parts of the body: in the cranial cavity, in the neck, in the 
thoracic cavity, in the abdominal cavity, in the pelvic cavity, and outside the body cavities. The 
hormones they release are important to body functions. They regulate basic drives and emotions,
such as sexual urges, violence, anger, fear, joy, and sorrow. They also promote growth and 
sexual identity, control body temperature, assist in the repair of broken tissue, and help to 
generate energy.

LYMPHATIC SYSTEM
The lymphatic system is a specialized part of the circulatory system. Its job is to carry some 



nutrients to cells, primarily fat, and to aid in the distribution of white blood cell which are part of 
the body's immune system.

GENITOURINARY SYSTEM
The genitourinary system includes the urinary and reproductive organs. Because these organs 
are located in the same area of the body, and share some functions, they often are treated 
together.

HEALTH AND FITNESS
Today, more and more people are concerned with their health and fitness. Participation in sports 
and exercises, concerns about diet and nutrition, and considerations of the household products 
used to maintain health are expanding. Because all of these are related to the anatomy and its 
processes in some way, it is worthwhile to be familiar with common illnesses, health care 
products, nutrition, and exercise.
NOTE: This section covers a number of topics within the general category of "Health and 
Fitness." The information contained herein is meant for general information purposes only, and a 
doctor or pharmacist should be consulted before starting on any diet, engaging in an exercise 
program, or treating any illness, 
as failure to do so could result in adverse side effects. A physician will be able to counsel you on 
your specific physiological needs better than the general information given here.

PROCESSES OF LIVING 
This section covers many of the processes of living including conception, pregnancy, and 
childbirth. It also give details on birth rates, mortality rates, and population growth. Other 
biological changes which occur during the course of one's life, such as menstruation and 
menopause, are also included.

GO BACK A SCREEN
As you explore through BODYWORKS, the program remembers all the steps you take. The "back
arrow" button lets you backtrack along that line of exploration. This helps if you get to some point 
where you'd like to back up and see what you've just previously covered.
Software Marketing Corporation

Animations

BODYWORKS includes three different types of animations. In order to run these animations 
make sure you have animations turned on in the Options menu.
The three types of animations are:
Animations occuring on the current image. An example of this type of animation is a beating heart
on the Circulatory System image. This type of animation runs continuously.

Animation cutaways. An example of this type of animation is the circles of muscles moving off the 
main image to reveal what lies beneath. The animation automatically runs once when you choose
a picture that includes an animation of this type.

Animations that are movie sequences. BODYWORKS includes several movie sequences. When 
a movie is available, there will be a small projector in the upper right corner of the picture
To run the movie, click on the projector button, or press F2 on the keyboard
You can also run movies from the movie list option found in the Tools menu.

When the movie is running, you can change several aspects of the way it plays. The commands 
are displayed on the right side of the movie screen.

Movie Commands

Full Screen:



To play your movie full screen, press
"F" (toggles on/off).

Speed:
To decrease the speed, press the left arrow key; to increase the speed, press the right arrow.

Zoom:
To make the image larger, press the "+" key; to make the image smaller, press the " " key.

Exit:
To exit back to the main screen, press <ESC>.

 
Bookmarks

The Bookmarks feature allows you to place bookmarks throughout the program as you browse. 
Just like regular bookmarks, they let you quickly go back to a position you've saved earlier. When 
you get to a place you'd like to come back to later, choose Set Bookmark from the Tool menu. 
This sets your current screen as a bookmark.
When you'd like to return to this screen, choose Browse Bookmarks, also in the Tool menu. This 
will display a list of all the set bookmarks. Select one of the bookmarks and it will take you to that 
screen
You can also set the bookmarks using the keyboard. The numbers one through zero on the 
keyboard correspond to bookmarks one through ten. To set a bookmark, simply press a number 
and that screen will be stored in that bookmark place. Be careful though, if a bookmark already 
exists in the slot you've chosen, it will be overwritten with the new entry. To return to that screen 
you can use the <Shift> key and the number of the bookmark.

Medical Records

The Medical Records option works as a database to store important medical information on you 
and up to 50 other people. It will store things such as name, address, allergies & prescriptions 
and any other medical history items. You can then print these out in a general form.
When you begin, the program gives you a screen which lets you manage the people you have in 
your database. This lets you add, delete, edit and print the individual entries. When you first 
begin, the list will be empty and you will need to add a new person with the "Add" button. It will 
ask you the name for the person, then let you begin editing the new record.

BODYWORKS provides an index to all the various information in the program. It may be called up
from the Index option under the Tools menu, or by pressing the letter "I". The index lets you go to 
any individual entry immediately. When the index screen comes up, you'll have a list of subjects 
and some control buttons at the bottom of the window. You can scroll down the list until you find 
an item you're interested in, then select it and press the "Goto" button. This will take you to that 
entry.
The index also lets you search for entries without having to scroll through the whole list. This can 
be done is several ways. If you start typing a word you're interested in, the list will follow your 
letters as you spell the word, trying to find an appropriate entry.

If this doesn't find your item, you can use the "Search" or "Match" buttons. "Search" allows you to 
find entries that sound like what you type in. This is helpful if you're not sure how an item is 
spelled. If you do know the spelling, "Match" will find items that match your word exactly. Either of 
these last two options will narrow your list to just those items that match your keywords. To get 
the full index list back, use the "Index" button. A help message displays at the bottom of the 
window explaining what each button does.



Font Setup

Font Setup lets you change the style of character used for text information. You can choose fonts 
from a variety of styles. The sample text lets you preview the different fonts. "Condensed 
Spacing" lets you have a more compact version of the font. This lets you see more text at once, 
but may not be as easy to read.

Color Scheme

Brightness will also affect the color used to highlight hypertext. With "Brightness" off, the highlight 
is white, with brightness on, the highlight is red.
You can also adjust the way text is displayed. The "Paper Mode" lets you have dark text on light 
"paper". If this is off, you have light text on dark paper.
 
Note Pad

The Note Pad lets you make personal notes as you explore through BodyWorks. You can enter 
your own comments, or pull in text items from the program itself. The pad has space for about 
15,000 letters which works out to about seven pages of text.  The "Clear" button gets rid of any 
text on the note
pad, letting you start over. "Exit" puts the note pad away. The contents of the note pad will be 
saved when you quit the program, so you can gather notes from several sources.

 
Lessons and Ouizzes

BODYWORKS has several lessons which let you explore different topics. They present individual 
items which relate to the topic in a step by step fashion. You can use the Lessons option under 
the Lessons menu, or by press "L" on your keyboard.

When you enter the lesson section, you are presented with several lessons you can take. When 
you select one, it will take you to the first item in the lesson and activate the Lesson controls. 
These are the Next Entry and Previous Entry items under the Lessons menu. They let you step 
through the elements of the lesson. You can also use "+" key to go to the next entry, and the " " 
key to go to the previous one.
At any time, you can end the lesson by selecting "Quit Lesson' from the Lessons menu.
 
QUIZ

Also available from the Lessons menu are several quizzes. The quizzes are a combination of 
multiple choice and identification questions. There are ten questions for each group. If you don't 
know the answer, you can use the "Surrender" button to have the program show you the correct 
answer

You can leave the quiz at any time by pressing the "End Quiz" button. The quiz will give you a 
score based on how many questions you got correct and how fast you answered.

The picture on the right is an example of the type of multiple choice question you will find in the 
BODYWORKS quiz.

The picture below is an example of an identification question found in the quiz:

 
Printing

BODYWORKS allows you to print text and graphics to a wide variety of printers. To do this, you 



must first tell the program some information about your printer and system. Select the Printer 
Setup option from the File menu. This will present you with a list of various printers. Here you 
should choose your printer, or the one closest to your model. See your printer's manual if you are 
unsure which printer to choose.

Once you have made your selection, you will be prompted to make some choices about the 
printer's settings. If a particular choice is not available for your printer, the text for it will be grey 
and you will not be able to select it.

The settings include what printer port the printer is connected to, what mode the printer is in, and 
whether it's a 9 or 24 pin printer. The port is usually LPT1 unless you have made some other 
explicit change.
If you choose one of the COM ports, a screen will come up to let you change the communication 
protocols for the printer. You will need to refer to your printer's manual to determine how to set 
these controls.

The printer settings mode choice will depend on your printer. Some printers offer an Epson mode 
or a Proprinter mode. Most printers that offer this option come standard in Epson mode. This 
information will also be found in your printer's manual. Once you have your choices selected, 
choose "Okay" to save the setup. If you make a wrong choice, you can always hit "Cancel" to go 
back a level, or simply choose Printer Setup again to start over.

After the printer has been set up, you can choose to print anytime you'd like. You can use the 
Print option under the File menu or press the letter "P". When you print, you have the choice of 
controlling how your printout will be composed.  If you don't want the dark background printed 
with your image, select the "Remove Backdrop" option before you select "Print." This option will 
save toner if you are printing to a laser printer.

The quality choices control how fine the dots are that are used to print the image. This will control 
the speed of printing. Draft quality has the grainiest look, but it prints the fastest. If your printer 
has color available, you can use it, or turn it off to print in black and white. If you are interested 
only in the text, the "Text Only" button. To send the information to a file for printing later, type a 
filename in the space provided. The name can include a path to where you'd like it stored.

BODYWORKS has options which control how light or dark the image appears on the printed 
page. The brightness and contrast for supported printers are set to values that should give good 
results. To change these values, press the "Brightness... " button. This calls up graphical slide 
controls that will let you adjust the image. As you move the controls, the screen will change to 
give you an idea of how the image will be affected. Once you have it set where you'd like, select 
"Okay" to print it. Experiment with various settings for the best output.
 
BODYWORKS has the ability to export both its graphics and its text. This lets you use them in 
other programs for reports or papers.

The graphic images are sent out in the PCX file format. This is a standard format for IBM PC 
systems and can be used with a wide variety of programs.

The text is saved as a text file and can be used with almost any word processor. Both formats are
commonly supported by desktop publishing packages. You can activate this function from the File
menu, or by using "E" on the keyboard.
 
4. BODYWORKS 3.0 for Windows: Getting Started

BODYWORKS is an interactive information system designed to let you explore the system, 
structures and functions of the human body   the ultimate machine. Information is illustrated in 
both text and pictures. The system lets you move from one item to another, in any way you'd like 



to investigate. 

The screen is divided into four main areas: the picture view box, the item list, the text box, and the
control buttons. A menu bar at the top provides access to functions which let you control your 
session and customize your program.

TEXT

The item list provides topics related to the current picture. The text for the selected topic is 
displayed in a box below the item list.  Scroll bars on the right side of the text box indicate there is
more text than currently displayed.
 
If you'd like more in depth information on a topic, click on its name in the item list. This will make 
the topic's text entry available, and draw a line to the item on the picture.

A small square appearing before an item name indicates that there is another picture associated 
with this item. To see this new picture, double click n the item name.

PICTURE LIST

The picture list is a specialized index to the pictures in BODYWORKS. Rather than having access
to all of the information in the program as you do with the standard index, this option lists the 
unique pictures only.
You can scroll down the list until you find an item you're interested in, select it and click the "Goto 
button. This will take you to that picture's screen.

The "Search" button lets you look for pictures without scrolling the list. The "Phonetic Search" 
option allows you to find entries that sound like what you type in. This is helpful if you're not sure 
how an item is spelled.

The search will narrow your list to just those items that match the keywords you type in. The 
"Index" button will restore the full index list after a search.

SOUND

To help with the pronunciations of different words, BODYWORKS has a speech option. The 
program will speak the name of the item when you select it in the item list.
A speaker icon appearing before an item name indicates the "speech back" feature is available 
for that item.
To hear the voice, the program requires a Windows compatible sound board t e installed in your 
system. Additionally, you will need to have a driver for the card installed in Windows system. This 
is done through the Drivers option in the Windows Control Panel. For help on configuring your 
sound card, please refer to your Windows manual and the documentation that came with your 
sound card.

 
MOUSE / KEYBOARD

When you use the program, you can select items by clicking on the name in the item list, or by 
clicking on items in the picture. If there is a small square next to an entry, you can select it a 
second time to take you to a new screen containing more information. This new screen will also 
have an item list that can take you to other screens. This lets you move from one topic to another,
in any order you'd like.



As you explore through BODYWORKS, the program remembers all the steps you take. The 
"Back arrow" button  lets you backtrack along that line of exploration. This helps if you get to a 
point where you'd like to back up and see what you've just previously covered.

The menu options are also available from the keyboard. To activate the menus, press the <Alt> 
key and the first letter of one of the menus, <Alt> F for example for the File menu. You can then 
navigate using the arrow keys and make your selection with <Enter>.

 
HYPERTEXT

When you are looking at the text entries for the various items in BODYWORKS, you will notice 
some words are highlighted. These are hypertext entries.

Hypertext is provided throughout the program to define terms and allow a way of branching off to 
other related issues.

Available Glossary Terms

When a hypertext word has several related items, you will be given a list. You can choose one 
item from the list, then click on "Goto", and move to that screen.  Clicking on a hypertext word 
will, in some cases, call up the Glossary to provide a definition for that word. This provides a 
quick reference source for unfamiliar terms. In other cases, clicking on a hyptertext word will take 
you to a new screen that gives more information about that item

VIEWS
There are different perspective views for many of the images in BODYWORKS. They let you look 
at the front, side, bottom and back of items. When these views are available, there will be buttons
at the bottom of the picture. You can click on these, or use the function keys listed on the buttons.

MOVIES
BODYWORKS includes several movie sequences. When a movie is available, there will be a 
small projector in the upper right corner of the picture. To run the movie, click on that button.
You can also run the movies from the Movie List option found under the Tool  menu.

 
THE MENUS
The menu choices let you interact with many of the functions BODYWORKS provides. The 
menus are File, Edit, Topics, Tools, and Help. you can activate the menus with your mouse, or 
from the keyboard with the <Alt> key and the first letter of the menu. <Alt-F> for example would 
activate the File menu.

THE BUTTONS

The body systems represent the different anatomical systems of the body. They include: skeletal, 
muscular, nervous, cardiovascular, respiratory, digestive, sensory, lymphatic, endocrine and 
genitourinary. There are also sections on health & fitness and living. These systems are accessed
through the family buttons at the top of the screen. This help section gives an indication of what 
each family covers.



SKELETAL SYSTEM
The skeleton is the framework of the human anatomy, supporting the body and protecting its 
internal organs. Two hundred and six bones compose the skeleton. This section covers these 
bones and the ways in which they are connected.

MUSCULAR SYSTEM
The human body contains more than 650 individual muscles anchored to the skeleton, which 
provide pulling power so that you can move around. These muscles constitute about 40% of your 
total body weight. The body is moved primarily by muscle groups, and not by individual muscles. 
These groups of muscles power all actions ranging from the threading of a needle to the lifting of 
heavy weights. This section covers this group.

NERVOUS SYSTEM
The nervous system of the human anatomy is responsible for sending, receiving, and processing 
nerve impulses. All of the body's muscles and organs rely upon these nerve impulses to function. 
Three systems work together to carry out the mission of the nervous system: the central, the 
peripheral, and the autonomic nervous systems. This section covers these systems and includes 
items such as the brain, the spinal cord and other nerve groups of the body.

CARDIOVASCULAR SYSTEM
In order for the body to stay alive, each of its cells must receive a continuous supply of food and 
oxygen. At the same time, carbon dioxide and other materials produced by the cells must be 
picked up for removal from the body. This process is continually maintained by the bodies 
circulatory system. The primary circulatory system consists of the heart and blood vessels, which 
together maintain a continuous flow of blood through the body.

RESPIRATORY SYSTEM
The respiratory system is responsible for supplying oxygen to the blood and expelling waste 
gases. This section covers the lungs, air passages and muscles which make the system work.

DIGESTIVE SYSTEM
The digestive system is responsible for processing food, breaking it down into usable proteins, 
carbohydrates, minerals, fats, and other substances, and introducing these into the bloodstream 
so that they can be used by the body. It includes the mouth, esophagus, stomach and intestines 
as well as the liver, gall bladder and pancreas.

SENSORY ORGANS
The sensory system includes the eyes, the ears, the nose and the mouth. The integumentary 
system is the name given for the skin, hair, nails, and glands covering the body. It is included here
as well, as the skin is the largest sensory organ.

ENDOCRINE SYSTEM
All the organs in the endocrine system are glands. They are unique from other glands, because 
they release chemicals known as hormones into general circulation. The organs of the endocrine 
system are located in widely separated parts of the body: in the cranial cavity, in the neck, in the 
thoracic cavity, in the abdominal cavity, in the pelvic cavity, and outside the body cavities. The 
hormones they release are important to body functions. They regulate basic drives and emotions,
such as sexual urges, violence, anger, fear, joy, and sorrow. They also promote growth and 
sexual identity, control body temperature, assist in the repair of broken tissue, and help to 
generate energy.

LYMPHATIC SYSTEM
The lymphatic system is a specialized part of the circulatory system. Its job is to carry some 
nutrients to cells, primarily fat, and to aid in the distribution of white blood cell which are part of 
the body's immune system.



GENITOURINARY SYSTEM
The genitourinary system includes the urinary and reproductive organs. Because these organs 
are located in the same area of the body, and share some functions, they often are treated 
together.

HEALTH AND FITNESS

Today, more and more people are concerned with their health and fitness. Participation in sports 
and exercises, concerns about diet and nutrition, and considerations of the household products 
used to maintain health are expanding. Because all of these are related to the anatomy and its 
processes in some way, it is worthwhile to be familiar with common illnesses health care 
products, nutrition, and exercise.
NOTE: This section covers a number of topics within the general category of "Health and 
Fitness." The information contained herein is meant for general information purposes only, and a 
doctor or pharmacist should be consulted before starting on any diet, engaging in an exercise 
program, or treating any illness, as failure to do so could result in adverse side effects. A 
physician will be able to counsel you on your specific physiological needs better than the general 
information given here.

PROCESSES OF LIVING

This section covers many of the processes of living including conception, pregnancy, and 
childbirth. It also give details on birth rates, mortality rates, and population growth. Other 
biological changes which occur during the course of one's life, such as menstruation and 
menopause, are also included.

GO BACK A SCREEN

As you explore through BODYWORKS, the program remembers all the steps you take. The "back
arrow" button lets you backtrack along that line of exploration. This helps if you get to some point 
where you'd like to back up and see what you've just previously covered.
 
ANIMATIONS

BODYWORKS includes three different types of animations:

* Animations occuring on the current image. An example of this type of animation is a beating 
heart on the Circulatory System image. This type of animation runs continuously.

* Animation cutaways. An example of this type of animation is the circles of muscles moving off 
the main image to reveal what lies beneath. The animation automatically runs once when you 
choose a picture that includes an animation of this type.
 
* Animations that are movie sequences. BODYWORKS includes several movie sequences. When
a movie is available, there will be a small projector in the upper right corner of the picture. To run 
the movie, click on the projector button. You can also run movies from the Movie List option found
in the Tools menu.

The movies include text beside the image window, describing what you are seeing. The movie 
window cannot be re-sized.

 
BOOKMARKS



The Bookmarks feature allows you to place bookmarks throughout the program as you browse. 
Just like regular bookmarks, they let you quickly go back to a position you've saved earlier. When 
you get to a place you'd like to come back to later, choose Set Bookmark from the Tools menu. 
This sets your current screen as a bookmrak.

When you'd like to return to this screen, choose Browse Bookmarks, also in the Tool menu. This 
will display a list of all the set bookmarks. Select one of the bookmarks and it will take you to that 
screen

MEDICA RECORDS

The Medical Records option works as a database to store important medical information on you 
and up to 50 other people. It will store things such as name, address, allergies & prescriptions 
and any other medical history items. You can then print these out in a general form.

The Medical Records window lets you manage your database. From here you may add, delete 
and edit individual entries. Use the "Add" button to call up a new Personal Information record 
entry form. Use the "Edit" button to call up an existing record for modification. Use the "Delete" 
button to remove a record from your database.

 
Enter your information into the fields provided. The fields will scroll as you enter your data, but all 
the information is still intact and saved. If you have more information than will fit in the top areas, 
you can include it in the large "medical history" section at the bottom.

Click "OK" to save your record. You may print the record from this screen. Clicking "Print" will 
send the information to your current Windows default printer. 

 
GLOSSARY

BODYWORKS' provides a glossary of some of the more uncommon terms used in the program. 
You can access the Glossary from the Tools menu. This will present you with a list of the terms 
available for definition. When you select one, the definition will be displayed in the text box below.
When you are done, select "Okay" to close the glossary.

INDEX

BODYWORKS provides an index to all the various information in the program. You can access 
the Index from the Tools menu. The index lets you go to any individual entry immediately. When 
the index screen comes up, you'll have a list of subjects and some control buttons at the bottom 
of the window. You can scroll down the list until you find an item you're interested in, then select it 
and click the "Goto" button. This will take you to that entry's screen.

The "Search" button also lets you look for items without having to scroll through the list. The 
"Phonetic Search" option allows you to re-find entries that sound like what you type in. This is 
helpful if you're not sure how an item is spelled.

COPY PICTURE

Select this option to copy the current image to the Windows clipboard. From there, you may paste
it into your favorite paint or word processing program for use in customized reports, or save your 
file to call back into the clipboard at a later time.

COPY TEXT



Select this option to copy the current text to the Windows clipboard. From there, you may paste it 
into your favorite paint or word processing program for use in customized reports, or save your 
file to call back into the clipboard at a later time.

As you step through the lesson, all of the other program's functions are still active. This lets you 
explore as you take the tour. When you are ready to go on, the "Forward" button will always take 
you to the next step.

QUIZ

The Quizzes option in the Tools menu provides an entertaining method of learning about 
anatomy. The quizzes are a combination of multiple choice and identification questions, with ten 
questions for each group. If you don't know the answer, you can use the "Surrender" button to 
have the program show you the correct answer.
You can leave the quiz at any time by pressing the "End Quiz" button. The quiz will give you a 
score based on how many questions you got correct and how fast you answered.

PRINTING

BODYWORKS allows you to print text and graphics to a wide variety of printers. To do this, you 
must first configure your printer through the Windows Printer Setup found in Control Panel.
You may not change your printer designation within Bodyworks. Your printout will be sent to your 
current Windows default printer. You may however, specify portrait or landscape mode, number of
copies and resolution through the Printer Setup option.  After the printer has been set up, you can
choose to print anytime by selecting the Print option under the File menu.  The current image is 
printed, along with the associated text.

5. Trouble Shooting

BODYWORKS is designed to run on as wide a range of machines as possible. Occasionally, 
people may have difficulties with some aspects of their system. This section lists some problems 
commonly experienced, and offers some solutions that may remedy the situation.

MOUSE
Problem: The mouse does not work at all.
Solution: Check that the mouse is properly connected to the computer. Make sure it
is plugged in properly and that it is in the right port. Most serial mice will plug into
the first serial port, COM1.

Problem: The mouse works in some programs, but not others
Solution: Most likely the mouse driver isn't loaded. The driver lets programs com
municate with the mouse. Some programs, like Windows, have this function built
in. Others rely on the driver being loaded when the computer starts up. Make sure
the mouse driver is loading properly (refer to the instructions that came with your
mouse).
Solution: The mouse's driver may not be responding properly to the program. You
can usually contact the mouse's manufacturer to get an updated driver.

Problem: The mouse seems to work, but moves erratically.
Solution: As the mouse moves, the roller can pick up dirt which builds up on the internal rollers. 
This causes them to stick and jump. A mouse clean kit will solve this problem.

Problem: As the mouse moves, it erases graphics and otherwise behaves erratically. This may 
be in some programs and not others.
Solution: This is almost always a mouse driver issue. The driver is not responding properly to 



requests from the program. Contact the mouse's manufacturer to get an updated driver.

DISKS

Problem: The computer won't read some disks.
Solution: The disks may be bad. Try them on another machine. If they work there,
inspect your drive, otherwise the disks are bad and need to be replaced.
Solution: The drive's read/write head may be dirty. This is especially true in dusty
or smoky environments. A drive clean kit can be purchased at most computer stores
to fix this problem.

Problem: You get a "General failure..." or "Invalid media..." message when you try to access or 
format a disk. 
Solution: These usually occur when the disk is the wrong density for the drive or
command. Example, a high density disk in a low or double density drive.

Problem: Installing software keeps asking for the same disk and several disks read as identical 
disks when they're really different. 
Solution: Disk caching software may be caching the directory of the disk improperly. You can 
solve this by disabling the caching software.
Solution: The cables inside which connect the floppy drive to the disk controller may not be 
seated properly. Make sure they're pressed on all the way.

Problem: Other people can't read disks you've made and you have problems with
disks at different times.
Solution: The drives read/write head may be out of alignment. This controls where
the information is written on the tracks. A technician will need to adjust this.

Problem: The drive does not respond.
Solution: It is possible your CMOS settings have been lost and the drive is not properly identified
to the computer. You will need to access your CMOS setup program to correct this problem. Refer
to your computer's user manual for information.

Problem: You get a message saying "Sector error..." and certain files cannot be accessed. 
Solution: The hard drive may have a bad sector where that information is stored, or the file is 
improperly identified in the drives storage map. The CHKDSK command can do some 
rudimentary checks of the disk's integrity. It is highly recommended that you look at a more 
sophisticated disk diagnostic tool to analyze the disk.

PRINTER

Problem: On a dot matrix printer, there are white lines through characters. 
Solution: This happens when one of the pins in the print head is broken. This must be fixed by a 
printer service center.

Problem: The print out has white lines through out it and the whole document is elongated. 
Solution: The printer's auto linefeed mode is enable which adds an extra linefeed after every 
carriage return. This is usually a switch setting on the printer itself. Refer to your printer's manual 
for information on setting this feature. 
Solution: On some printers, the linefeed mechanism and platen can fall out of adjustment. This 
causes a misfeed as it advances the paper. This must be corrected by a printer service center.
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Problem: When printing to a laser printer, you get only part of the image or a blank page
Solution: The printer doesn't have enough memory to store the image at the resolu



tion you requested. A full page 300 dpi image takes about 800K, plus overhead for
the printer. Try printing at a lower resolution to solve the problem.

Problem: The printer prints "garbage" on the page.
Solution: Most likely the printer driver is set up improperly. Programs need to
know how to send information to the printer. If the driver is set for a printer other
than the one you're using, the printer will not know how to respond. Be sure to
select the proper driver for your printer. Your printer's manual should tell you what
driver to select.
Solution: The cable may not be connected properly. This will introduce random sig
nals, garbling the output. Check to see that the cable is connected properly.

Problem: Output from a laser printer is streaked, either black or white. 
Solution: Build up on the corona wires or photo drum can streak the toner. Try cleaning the 
corona wires very carefully. If the problem persists, try replacing the toner cartridge.

MEMORY

Problem: Programs say "Not enough memory"

Cause: The first 640K of memory is the area that is most important for DOS pro
grams. If you have "memory resident" programs that load when the machine starts
up, these will eat up part of that 640K. This can get to the point where there is not
enough memory to run other programs.

Solution: You can create a bootable system disk that doesn't have the memory resi
dent programs load. You can boot off this disk when you'd like to run certain, mem
ory intensive programs. Your DOS manual will explain how to make this disk.
Solution: Modify your CONFIG.SYS and AUTOEXEC.BAT files to remove or limit
the number of programs that eat up your memory.
Solution: Memory managers are available that let you load some of these programs
into other sections of memory, free your 640K for other programs. These are available at most 
computer stores.
*Note: You can use the both the CHKDSK and MEM commands to tell you how much memory 
you have available at any time. 
**Note: Refer to you software's documentation before you attempt any changes to your 
configuration.

CONFIG.SYS

A CONFIG.SYS file holds commands which configure the way the system will load. It typically 
holds instructions for memory managers, file space allocations, mouse allocations, mouse 
drivers, compression drivers, and other memory resident programs. These programs may 
sometimes interfere with other programs. In this case you can either disable the whole CONFIG, 
or selective parts of it. To disable it, create a bootable disk (see DOS manual) and use that disk to
boot from. Since it doesn't have a CONFIG, you will have bypassed the current one without 
having to change it.

There may also be additional drivers that are required by your system. This is especially true if 
you are using compression software. If this is the case, refer to the compression program's 
documentation for instruction.

If you need to track down a conflict with a specific package, you can use a REM statement (see 
DOS manual). The REM disables the statement that follows it, turning it into a REMark. The 
procedure for doing this is to REM out all of your CONFIG statements, reboot and see if the 
program works. If it does, edit your CONFIG and start taking out the REMs, one at a time. Reboot



between each change. If you remove a REM statement, and the program stops working. That line
is your culprit.
For more information on the CONFIG.SYS, see your DOS manual.

AUTOEXEC.BAT

The AUTOEXEC.BAT file is used to list a set of commands that run when the machine first starts 
up. Some of these commands are used to configure the system like PATH, PROMPT, and SET 
TEMP. Other commands run memory resident programs that enhance your system (things like 
MOUSE, SMARTDRV, etc).

The memory resident programs can have the unwanted side effect of using up part of the main 
640K memory that DOS uses for its programs. This can keep you from running certain programs. 
To avoid this, you can create a bootable system disk that doesn't have an AUTOEXEC.BAT. This 
will allow you to boot the system, without those initial programs running.

There may be some programs that are required by your system to allow it to function. This is 
especially true with compression programs. If this is the case, refer to your documentation for 
more information.
If you need to track down a conflict with a specific package, you can use a REM statement (see 
DOS manual). The REM disables the statement that follows it, turning it into a REMark. The 
procedure for doing this is to REM out all of your AUTOEXEC statements, and reboot. If the 
program works, edit your AUTOEXEC and start taking out the REMs, one at a time. Reboot 
between each change. If you remove a REM statement, and the program stops working, that line 
is your culprit. For more information on the AUTOEXEC.BAT file, see your DOS manual.

WINDOWS

Problem: Certain operations like installations or printing get part way through and
then stop, sometimes with an error.
Solution: Windows makes temporary files as it works. These are placed in the direc
tory pointed to by the 'SET TEMP=' line in the AUTOEXEC.BAT file. You must
have this line in the AUTOEXEC, the directory must exist, and there must be enough
space on the drive to hold the temporary files. If the drive runs out of space, that's
when the function will have problems. It is recommended to have about two
megabytes free on the drive holding temp files.

Problem: You get garbled graphics on the screen in certain programs. 
Solution: Newer systems have been including high resolution SVGA cards. These offer 
tremendous image quality. To achieve this in Windows, they need a special video driver from the 
manufacturer to support the enhanced features. These can sometimes cause conflicts with 
certain programs. To see if this is the case, switch to the standard VGA driver by using the 
'Windows Setup' program in the 'MAIN' group. If the program now functions properly, contact you 
video card's manufacturer for an updated video driver.

Problem: You have several types of problems printing.
Solution: Windows also uses drivers to communicate with printers. There are a
great many available in the program. You need to be sure that the driver you are
using is the one specifically for your printer. You can find this information in the
'PRINTERS' 'CONTROL PANEL' in the 'MAIN' group. If it is not the right driver,
contact either Microsoft or the printer's manufacturer to get the appropriate driver.
Solution: Your printer's driver may have a conflict with your SVGA video driver.
You can see if this is the case by switching to standard VGA (see above).
Solution: You can try disabling 'PRINT MANAGER' and connecting the printer to
'LPT1.DOS' or 'LPT1.OS2'. This will make Windows send the information more
directly to the printer.



Solution: If you have a newer printer, you may need to contact the manufacturer to
get the latest driver from them.

#Note: Refer to your Windows manuals first if you are experiencing any of these problems.
General Protection Faults (GPF)

The most common cause of GPFs is improper memory access. Windows manages all the 
memory on your system, and if a Windows application, Windows itself or a device driver 
accesses memory not assigned to it, a GPF usually occurs.
 
Is Windows correctly configured for your hardware?
Windows Setup detects the type of machine you have, but may not correctly identify your 
machine. To verify that Windows is configured correctly for your computer, exit Windows and run 
SETUP at the DOS prompt.
In the System Information section of the Windows Setup screen, make sure that the correct 
machine type appears in the Computer text box. If it does not, move the highlight to that text box, 
press Enter, and then select the correct machine type from the resulting list. If your machine type 
is not specifically named, choose MSDOS SYSTEM.
If you are connected to a network, verify that your network is properly listed in the Network text 
box.

Is the GPF reproducible?
GPFs caused by applications are reproducible, making it easy to document when and where the 
GPF will occur.
Random GPFs usually indicate a memory conflict or hardware problem. Eliminating these GPFs 
requires you to examine your system carefully.

Where does the GPF occur?
You will get an idea of what may be involved in the GPF by noting what module it occurs in.
KRNL386 has to do with memory
GDI deals with graphics and printing
USER deals with user input and output (keyboard, mouse, sound driver, communications ports

If a GPF is random. it's usually a memory conflict or hardware problem.
Check for TSR conflicts or device drivers by removing all unnecessary commands from the 
Autoexec.bat and Config.sys files.
Reduce the Config.sys to the following commands (change the drive and directory to match yours
if they differ from your system): DEVICE =C: \ WINDOWS \ HIMEM. SYS FILES=60 
BUFFERS=20 SHELL=C:\DOS\COMMAND.COM C:\DOS /E:2048 /P
NOTE: There may also be additional drivers that are required by your system. This is especially 
true if you are using compression software. If this is the case, refer to the compression program's 
documentation for instructions.

Reduce the Autoexec.bat to the following commands:
PROMPT $P$G
PATH=C: \WINDOWS;C: \;C: \DOS
SET TEMP=C:\WINDOWS\TEMP

Reboot your machine and load Windows as usual. If you are now able to run without the GPF 
occurring, you probably have an incompatible TSR or device driver. The tedious part will be 
adding commands back to your Autoexec.bat and Config.sys files one at a time, to determine 
which one caused the GPF.

Check for bad sectors in the permanent swap file
If your system reports occasional read or write errors when accessing the hard drive, there may 
be bad sectors in the permanent swap file. If Windows accesses a corrupted area of the 



permanent swap file, it may wrongly report that an application caused a GPF. This is probably the
leading cause of seemingly random GPFs caused by several applications.

 * First remove the permanent swap file (Control Panel, 386 Enhanced, Virtual Memory). 
 * Next, run Norton Disk Doctor or PC Tools Disk Fix (or other hard drive utility) to find and mark 
the     bad sectors on the hard drive. 
 * Finally, re create the permanent swap file.

Check third party device drivers for conflicts
If you use a third party device driver for your video graphics card, mouse, or network, you should 
configure Windows to use its own device drivers when you troubleshoot for GPFs.
To do so, select Main, Windows Setup, Change System Settings and then configure Windows for 
a VGA display, no mouse and no network. If you choose to leave the mouse driver installed, you 
must realize that it can be a source of conflict.

Restart Windows for your changes to take effect. If the GPF no longer occurs, you can use a 
process of elimination to discover which device driver causes the problem to occur.

If a specific device driver or application causes a GPF, re install it.
If any of the files a device driver or application uses becomes corrupted or dama~ed, re installin~ 
the software may correct the problem.

Check Windows INI files for additional third party device drivers.
Using SysEdit or Notepad, open your SYSTEM.INI file. In the [boot] section, check to see if any of
the following settings differ from these defaults:

SHELL=PROGMAN.EXE
SYSTEM.DRV=SYSTEM.DRV
KEYBOARD.DRV=KEYBOARD.DRV
MOUSE.DRV=MOUSE.DRV

If any of your settings differ from these, you will need to comment out the differing settings, and 
add the respective default setting. To comment out a setting, place a semicolon (;) at the 
beginning of the setting's line. This tells Windows to differing settings, and add the respective 
default setting. To comment out a setting, place a semicolon (;) at the beginning of the setting's 
line. This tells Windows to ignore that line in the INI file. After making changes, choose FILE 
SAVE.

Next open your WIN.INI file, and locate the following settings: LOAD= RUN=
If these settings don't appear as these defaults, comment them out and add the default settings 
on a new line. After making changes, choose FILE SAVE.

Now, restart Windows, and if the GPF no longer occurs, you can use a process of elimination to 
discover which setting causes the GPF to occur.

Page Mapping Conflicts

A page mapping conflict occurs when Windows (in 386 Enhanced) and a device driver or 
application try to use the same Upper Memory Block.
While Windows 3.1 will not try to use a UMB that the expanded memory manager is already 
using, it may try to use one of the UMBs a device driver or application is using, and a page 
mapping conflict occurs.
To test for a page mapping conflict, start Windows with the following command line: WIN /3 /d:x
The /3 command line switch forces Windows to run in 386 Enhanced mode.
The /d:x command line switch tells Windows not to use the UMA. This switch is equivalent to 
adding the setting EMMExclude=A000 EFFF to the [386Enh] section of the SYSTEM.INI file.



If the GPF no longer occurs, you probably have a page mapping conflict.
To further pinpoint where the page mapping conflict occurs, you can add EMMExclude= settings 
to the [386Enh] section of your SYSTEM.INI file. Move to the [386Enh] section of your 
SYSTEM.INI and add the following five settings:

EMMExclude=A000 AFFF
EMMExclude=B000 BFFF
EMMExclude=C000 CFFF
EMMExclude=D000 DFFF
EMMExclude=E000 EFFF

Note the semicolon at the beginning of the last four EMMExclude= settings, instructing Windows 
to ignore these lines. Now, when you save your changes and restart Windows, it will exclude only 
the UMA area from A000 AFFF.
If the GPF no longer occurs, then the page mapping conflict involves the area A000 AFFF
If the GPF continues to occur, you will need to use a process of elimination to locate where the 
conflict occurs. Simply edit the SYSTEM.INI file to exclude only one area of the IJMA nt A time

FOR FUTHER ASSISTANCE:

If you are still having problems with BODYWORKS, you can contact our technical support 
department. Before you contact us, please take some time to fill out the User Support form on the
next page.
Once you have this form filled out, you can contact our technical support team Monday through 
Friday, 9:00 am to 8:00 pm (Eastern Standard Time). You may also fax requests for support to our
24 hour fax line, and one of our technical support representatives will contact you. You may also 
mail your request for support.

By phone: Call our technical support team at (770)428 0008
By fax:    Fax a copy of the User Support form to (770)427 1150
By mail:Mail a copy of the User Support form to:

SoftKey International Inc.
450 Franklin Road, Suite 100

                       Marietta, GA 30067

Our technicians make every effort to provide you with a quick response time to your problem. 
However, at times the volume of incoming calls makes it impossible to immediately connect you 
to a technician.
If you choose to hold, please be aware that we will make every effort to get to your call as soon 
as possible, while giving the current customer the same courteous service they will give to you.
If you do not wish to hold, please leave a voice mail message, and one of our technicians will 
return your call. We strive to return your call on the same day, however, please be aware that the 
volume of waiting callers on hold may make it impossible to return your call before the following 
day. If you do leave a voice message, please advise us of the best time to return your call.
 


